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Livestock Manure N Farm Limit

The Nitrate Vulnerable Zone (NVZ) regulations establishes a rule which limits the loading of livestock
manure to land that is in an NVZ on farms in Scotland. In any year beginning 1 January, the total amount
of nitrogen in livestock manure that is applied to a farm, whether directly by grazing animals or by
spreading, must not exceed 170 kg N multiplied by the area of land on the farm that is in an NVZ (in
hectares). If the farm has an approved application for derogation, the limit is increased to 250 kg N
multiplied by the area of the farm (in hectares).

The nitrogen from manufactured fertiliser, and any other organic manure that does not originate from
livestock (e.g. sewage sludge, compost), does not count towards the limit.

For details of these regulations, see the NVZ Guidance available from the PLANET Library.

The PLANET Livestock Manure N Farm Limit module calculates the N capacity and N loading of a farm
and will help assess if the farm is compliant with this limit.

Important

The information supplied in the PLANET software is for guidance purposes only and is not intended to
fully substitute for professional agricultural advice. The specific statutory elements concerning water and
nitrates are set out in the relevant national legislation land and you should refer to this legislation to find
out exactly what you must do. The nutrient recommendations provided by PLANET are in line with
national industry standard guidance. If in doubt, farmers should seek help from a qualified adviser.

The user is responsible for ensuring the accuracy and completeness of all data entered and used by
PLANET, and for any commercial decisions taken based on any of the PLANET recommendations or
other outputs of this software. Use of the PLANET software is subject to the terms and conditions of the
PLANET User Licence.

PLANET v3 has been developed by ADAS and SRUC with funding and support from Defra and the
Scottish Government. The software is maintained by ADAS. Support is provided by ADAS (in England
and Wales) and SRUC (in Scotland). For further information, visit www.planet4farmers.co.uk or ring the
PLANET Helpline on 08456 023864.

PLANET v3.3 Farm Livestock Manure N Farm Limit Help (PS).doc Page 2 of 8




Getting started

To use this module, you must first either create a new farm file or open an existing farm file. If you are
starting a new file, then as a minimum you must enter the Farm name, STD code and Postcode in the
Farm Details tab before you can open the module — but you do not need to enter any other information.
You will be prompted to save any changes before you enter the module.

To use the module, select the Livestock Manure N Farm Limit icon E from the task bar at the top of
the screen, or select Livestock Manure N Farm Limit from the View menu.

The module will appear with three tabs (screens).
e Farm and Livestock Details
e Imports and Exports

e NVZ Compliance

You will then need to enter information for your farm into the Farm and Livestock Details tab, and then
into the Imports and Exports tab. The NVZ Compliance tab is the output tab providing calculated values
for the permitted livestock manure N capacity and the calculated N loading of the farm.

Further information to help with data entry is provided throughout PLANET by hovering over column

headers that have an - icon, or by clicking in any data entry cell and then pressing the F1 key. This
will take you to Help about the current screen.

Important. You can only save one set of data in this module. For instance, if you enter data for a
calendar year then this will be saved on your computer. However, if you then edit this data (e.g. for a
later calendar year) the original data will be overwritten and only the new data will be saved. Therefore, if
you wish to keep a permanent record of the PLANET calculation and report for a particular calendar
year, you should either print out a hard copy of the PLANET report before making any edits to the data,
or use the Save As function in the File menu to save each set of data as a separate Farm file which you
will need to name individually.
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Farm and Livestock Details Tab

m PLANET - Livestock Manure N Farm limit for calendar year 2010 g@g|
File  view Tools Lbrary  Help
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Farm Details
Calendar pear 2010 * i Does the faim have derogation No
i Areaof tamed land in an NVZ 80.00) ha PFermitted livestock manure total N capacity 13,600 kg Ny
i freacffamedlandnotinan V2 | 2000] ha

Total area of Farmed land : 10000 ha

Livestock Details Imports and Exports

Livestack group | i, Livestock typs i Aversgenumber| i, Oocupancy i Nstandard Totsl N produced

for year % ka/ur kadyn
Catle 1 daity cow (5000-3000 lives mik yield) 150 101.0 15,150
Cattle 1 daity heifer replacement, 13 months 1o fist calf ki £1.0 2135
Cattle 1 dairy heifer replacement, 3-13 months i 350 1,225
Catle 1 call. upto 3 months 50 84 420
Cattle 1 bull for breeding, 25 months and over i 420 48

Tatal 18.978

Current file: scotland 2%june ps.mdb PLAMNET version 3 (Scotland)
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1. Select the Calendar year from the drop-down list. This is the 12 month period starting 15t
January for which you are going to enter data.

2. Enter the Area of the farm in an NVZ including the area of rough grazing land but excluding
areas of surface water, any hard-standing, buildings, roads or woodland unless the woodland is
used for grazing. Be careful to enter information in hectares (ha).

3. Enter the Area of the farm not in an NVZ.

4. The Permitted livestock manure total N capacity (as kg N/year) for the farm is calculated
using the maximum permitted livestock manure N loading of 170 kg N/ha averaged across the
area of the farm that is in an NVZ. If the farm has an approved derogation for the calendar year
then select ‘Yes’ against Does the farm have a derogation? — the permitted livestock manure N
capacity will then be calculated using the limit of 250 kg N/ha.

5. Next select the Livestock group and Livestock type for each type of livestock that you have on
the farm during the calendar year. For each Livestock type, you will first have to select the
appropriate Livestock group (e.g. cattle), then select the Livestock type (e.g. 1 dairy cow, 6000-
9000 litres milk yield). You must include livestock kept on any land in an NVZ that you rent under
a Short Limited Duration Tenancy of 2 years or longer.

6. Enter the average Number of each livestock type that are on the farm for the whole calendar
year, including livestock kept on any land in an NVZ that you rent under a Short Limited Duration
Tenancy of 2 years or longer. Allow for livestock that are grazed on any seasonal land or land
that is not in an NVZ (e.g. the ‘Area of land not in an NVZ’) — this manure does not count towards
the manure N loading of the farm. If livestock are on the farm (land in an NVZ) for only part of the
year then enter the pro-rata number. For instance, if there are 30 dairy heifer replacements for
just 4 months then enter the number 10 which is the pro-rata average number for the year (30 x
4/12 = 10); this is equivalent to having 10 heifers for the whole year. For pigs and poultry where
there are usually several ‘batches’ of livestock grown in a year, enter the number of ‘places’ — the
standard values of Total N produced for these livestock types are expressed on a per place
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basis . Poultry are in units of 1,000 bird places so, for example, enter 50 for 50,000 laying hen
places.

7. Once you have entered details for each livestock type, the standard value for the Total N
produced by 1 unit of the livestock type is shown automatically. These are standard values that
have been set in the Regulations. The total N produced by each livestock type is calculated
automatically by multiplying the Number of livestock by the Total N produced by 1 unit. The
total N produced by all livestock on the farm is summed and appears at the bottom of the screen.
You cannot change these standard values for cattle or sheep but you can for pigs and poultry if
you have used the ENCASH computer software. ENCASH calculates a specific value for the total
N produced by a livestock type based on the specific diet and production system on your farm.

8. To delete a row of information, highlight the row by clicking on the small cell at the far left hand
end of the row then press the Delete key. If you hold down the Control key, you can select
multiple rows. To clear all the information on this tab (screen), click the right mouse button and
select Clear this tab. To clear information on all the tabs (screens) in this module select Clear all
tabs.

9. When you have entered details for all the livestock kept on the farm, click on the Imports and

Exports tab. If you have not imported or exported livestock manures during the calendar year,
click on the NVZ Compliance tab.
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Imports and Exports Tab

This allows you to enter details of any imported or exported livestock manures (if any). Enter details of all
livestock manures imported onto, or exported off, the ‘Area of the farm that is in an NVZ’ during the
calendar year, including home-produced manure applied to the ‘Area of the farm that is not in an NVZ'. If
you do not import or export manures leave this tab blank and move straight to the NVZ compliance tab.

m PLANET - Livestock Manure N Farm limit for calendar year 2010 g@@l

Flle  Wiew Tools Lbrary Help
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Farm Details

2010

80.00] ha
2000] ha
Total area of Farmed land : 10000 ha

13600 kg Ny

Livestock Details Imports and Exports

Load manure data

Import/esport  Date i, Marure type Tatal N i, Supplievesipient
ka

Quartity i, Total N content
tonnes or P kast or kag/n?

Ezport 05/05/2010  Caltle F¥'M - fresh 280 [11) 1500 John Smith
Export 03/04/2010 | Caltle sluny, mech separated liquid 2 30 210 Bill Herry
¥g | Import 03/03/2010  Pig FY'M - fresh 200 70 1.400 FEEEH

Import total. 1,400
Export totak 2310
Nt total 910

Current file: scotland 2%june ps.mdb PLAMNET version 3 (Scotland)
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1. If you have previously entered data into the separate Organic Manure Imports and Exports module,
you can load this data by clicking the Load data button. If you then select ‘Yes’ to loading the data,
data for all Organic manure imports for the 12 month period will automatically be imported to this tab.
Note: If you select to import data using the Load data button, this will overwrite any data that has
already been entered into this tab.

2. If you do not want to import data using the Load data button, then select Import or Export from the
Import/Export drop-down list.

3. Select the Manure type that is being imported or exported from the drop-down list e.g. Broiler/Turkey
litter. If you apply home-produced livestock manure to the ‘Area of land that is not in an NVZ', then
you should enter this manure as an export so that this manure does not count towards the N loading
of the farm. Note: On derogated farms, you are not allowed to import manure from non-grazing
livestock (e.g. pigs or poultry) to any of the ‘Area of land in an NVZ' during the calendar year.

4. Enter the Quantity of each manure type, being careful to enter information in the required units.

5. Once a manure type has been selected, it's standard Total N content will be shown automatically.
This figure can be edited if you have undertaken specific sampling and analysis of the manure using
the standard method (see NVZ Guidance leaflet 3). If you have selected an Other manure type, enter
the total N content of this manure. The Total N (kg) of each manure type that is imported/exported is
calculated automatically. The total N (kg N/yr) imported and exported in manure is shown at the
bottom of the screen, as well as the net total (i.e. imports minus exports).

6. Click in the cell in the Supplier/Recipient column and enter details of the supplier of imported
manures or the recipient of exported manures.
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7. To delete a row of information, highlight the row by clicking on the small cell at the far left hand end of
the row then press the Delete key. If you hold down the Control key, you can select multiple rows. To
clear all the information on this tab (screen), click the right mouse button and select Clear this tab. To
clear information on all the tabs (screens) in this module select Clear all tabs.

8. When information for all imports and exports of livestock manures during the calendar year has been
entered, then click on the NVZ Compliance tab. You will be prompted to save any changes.
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NVZ Compliance Tab

This tab summarises the information that has been entered into the module and calculates the livestock
manure total N capacity, production and loading for the ‘Area of the farm in an NVZ'.

[l PLANET - Livestock Manure N Farm limit for calendar. year 2010

File View Toos Lbrary  Help

B | avSAEN = Ok @

Farm Details

Calendar pear 2mo i Does the fam have derogation Mo

i Areacf famed land in an NVZ : 8000 ha Parmitted livestack manure total N capaciy: 13800 kg N

i dreaof farmed land not in an NvZ 2000 ha
Total area of farmed land : 10000 ha

Livestock Details Importsand Exports SIS
e Area (ha) Manwre total N (ka/n) B
Areaand livestock manure total N capacity
Area of holding in an NVZ B0.00 13,600.00
‘Area of helding et in an HVZ am
Total 100.00 13,600.00
Livestock manure total N loading =
Home-pioduced livestock manures
Grazing Ivestock 18378
Pigs and pouly o
Imported livestock marures
Grazing livestock 0
Pigs and pouliiy 1,400
Ewported livestock manures
Grazing vestock 2310
Pigs and pouly o
Nettotal from grazing ivestock 16,668
et total from pigs and poultry 1.400
Compliance with N Farm Linit
18,068

Livestock manure total N loading over the farmed area

Current file: scotland 29june ps.mdb PLANET version 3 (Scotland)
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Report

To view and print a report, select the report icon | = | from the task bar at the top of the screen. The
report includes some information about this NVZ rule but further details can be found in the NVZ
Guidance available from the PLANET library.

To return to other modules in PLANET select the required icon from the task bar or use the View menu.
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